
Getting Started with Order Analysis
NI Sound and Vibration Measurement Suite Version 5.0

This document provides an introduction to the order analysis tools that the 
NI Sound and Vibration Measurement Suite provides. This document also 
contains exercises that you can use to learn how to build order analysis 
applications with the Order Analysis Express Measurements VIs. These 
exercises take a short amount of time to complete and help you get started 
with the order analysis tools. 

The following resources contain information you might find useful:

• LabVIEW Help, available by selecting Help»Search the 
LabVIEW Help

• Getting Started with LabVIEW

• LabVIEW Sound and Vibration Analysis User Manual

Contents
Introduction to Order Analysis ............................................................... 2

Order Analysis Applications............................................................ 2
Performing Order Analysis with Example VIs................................ 3

Building an Order Analysis Application................................................. 3
Description of the Device under Test .............................................. 3
Analyzing the Example Data ........................................................... 4

Loading the Example Data ....................................................... 5
Analyzing the Speed Profile ..................................................... 5
Analyzing the Colormap........................................................... 7
Analyzing the Order Power Spectrum...................................... 9
Analyzing the Magnitude Plot .................................................. 12
Extracting Order Waveforms.................................................... 15

Summary ................................................................................................. 18



Getting Started with Order Analysis 2 ni.com

Introduction to Order Analysis
Order analysis is a technique for measuring and analyzing sound and 
vibration signals generated by rotating or reciprocating machinery, such as 
engines, compressors, turbines, and pumps. These machines have a variety 
of parts, and each part contributes a unique sound and vibration pattern to 
the sound and vibration pattern of the whole machine. With order analysis, 
you can identify and isolate these sound and vibration patterns to analyze 
the performance and quality of each machine part individually. The 
information you gather with order analysis often is difficult to acquire with 
traditional sound and vibration analysis methods.

Traditional sound and vibration analysis methods such as Fast Fourier 
Transform (FFT) analysis cannot detect mechanical characteristics that 
change with speed. Order analysis, on the other hand, enables you to 
identify data at various orders, or harmonics of the rotational speed. The 
first order refers to the speed at which the machine rotates. Each order 
thereafter is a corresponding multiple of the rotational speed. The second 
order is twice the rotational speed and the third order is three times the 
rotational speed and so on. Using order analysis, you therefore can analyze 
signal variations due to changes in speed.

Order Analysis Applications
In general, you can perform order analysis in the following types of 
applications:

• machine condition monitoring (MCM)

• noise, vibration, and harshness (NVH) testing

MCM applications typically analyze vibration response data to identify 
defective parts and ensure continuous performance. NVH applications 
typically analyze sound and vibration data to verify the quality of a system 
and identify parts that produce unwanted sound or vibration.

Unlike MCM applications, NVH applications generally analyze the sound 
and vibration of machine parts that function properly. For example, 
commercial airplane engineers might use NVH analysis to reduce cabin 
noise. With NVH analysis, the engineers can isolate and identify the source 
of the unwanted noise, such as the aircraft engines. The engineers then can 
redesign the rotating part of the engines and verify the improvement, again 
using NVH analysis.

You can use the order analysis tools in the NI Sound and Vibration 
Measurement Suite to develop both MCM and NVH applications.
This document focuses on using these order analysis tools for NVH 
applications. The Sound and Vibration Measurement Suite provides Order 
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Analysis VIs and indicators with which you can develop a complete
NVH application, from the logging of online data to data analysis and 
presentation.

Refer to the LabVIEW Help for more information about order analysis 
theory and applications.

Performing Order Analysis with Example VIs
The Sound and Vibration Measurement Suite includes examples to
help you get started with order analysis. Select Help»Find Examples
in LabVIEW to launch the NI Example Finder. Select Toolkits and 
Modules»Order Analysis in the Browse tab to view all of the available 
examples, or use the Search tab to locate a specific example.

You use an example VI that the Sound and Vibration Measurement Suite 
provides to perform the exercises in the Building an Order Analysis 
Application section.

Building an Order Analysis Application
In this section, you use the order analysis tools in the NI Sound and 
Vibration Measurement Suite to build a noise, vibration, and harshness 
(NVH) testing application. You use these tools to perform offline order 
analysis on example data. This example data represents the speed and 
vibration amplitude of a computer fan during a run-up test. The exercises 
in this section illustrate the common analysis methods you can use to 
acquire information about the orders in the data.

You can complete the exercises in this section in approximately 40 minutes.

Description of the Device under Test
An effective order analysis application requires a thorough knowledge of 
the device under test (DUT). The more information you have about the 
DUT, the more useful the analysis you perform can be in understanding the 
behavior of the system.

The DUT for the exercises in this section is a computer fan with four coils 
and seven blades. The example data you use represents a 15-second run-up 
test of the computer fan. Run-up and run-down tests are useful for 
identifying orders that generate significant amplitude only when the DUT 
approaches or surpasses the critical speed, or resonant frequency.
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Analyzing the Example Data
The Order Analysis Express Measurements VIs provide common analysis 
methods you can use to acquire information about the orders in a sound or 
vibration signal. You can use these Express VIs to analyze the computer fan 
run-up data.

In the following exercises, you use the Getting Started Exercise (Empty) 
example VI as a template to build an order analysis application with the 
Order Analysis Express Measurements VIs. You can access the Getting 
Started Exercise (Empty) example VI by selecting Help»Find Examples 
from the pull-down menu and selecting Toolkits and Modules»Order 
Analysis»Getting Started in the NI Example Finder window.

When you complete these exercises, the block diagram of the Getting 
Started Exercise (Empty) example VI should appear similar to the block 
diagram of the Getting Started Exercise (Completed) example VI, as shown 
in Figure 1.

Figure 1.  Block Diagram of the Getting Started Exercise (Completed) Example VI

The Getting Started Exercise (Completed) example VI uses the colormap, 
order power spectrum, magnitude, and order waveform plots to analyze the 
sound and vibration data from the computer fan. Each plot displays the 
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same information from a different perspective. You can use these plots to 
analyze the example data and gain a fuller understanding of the DUT.

Loading the Example Data
You can use the Getting Started Exercise (Empty) example VI as a template 
VI to build an order analysis application that analyzes the example data 
with a variety of plots.

Complete the following steps to load the computer fan run-up data to use in 
the Getting Started Exercise (Empty) example VI.

1. Launch the Getting Started Exercise (Empty) example VI.

2. Click the Browse button next to the Data path text box and navigate 
to the PC Fan runup.dat file in the labview\examples\Order 
Analysis\Example Data directory.

3. Click the OK button. The filename appears in the Data path text box.

4. Click the Run button to run the Getting Started Exercise (Empty) 
example VI.

5. Select File»Save As and save the VI as Getting Started 
Exercise.vi in an easily accessible location.

The Getting Started Exercise VI displays the waveform of the computer fan 
run-up data in the Input signal plot on the front panel. This VI also returns 
the tachometer information for the input signal in the Tacho info indicator. 
Notice that the number of pulses per revolution of the tachometer is two.

Analyzing the Speed Profile
The Input signal plot of the Getting Started Exercise VI is a vibration 
signal plot. Vibration signal plots illustrate how sound or vibration signals 
change over time. You can use a speed profile plot to illustrate how 
rotational speed changes over time. You then can use these two plots in 
parallel to observe how raw sound or vibration changes with speed.

The Analog Tacho Processing Express VI uses an analog tachometer signal 
to determine the rotational speed of a DUT. You can use this Express VI to 
compute the rotational speed of the computer fan.

Press the <Ctrl-E> keys to switch to the block diagram of the Getting 
Started Exercise VI. Notice that the oax_Load Data (Analog Tacho, single 
channel) VI loads the example data and returns the vibration signal, an 
analog tachometer signal, and information about the tachometer. You also 
can see several indicators on the block diagram of the Getting Started 
Exercise VI. You will use these indicators in later sections.
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Complete the following steps to compute the rotational speed of the 
computer fan and to display the information in a speed profile plot.

1. On the Order Analysis Express Measurements palette, select the 
Analog Tacho Processing Express VI and place it on the block diagram 
of the Getting Started Exercise VI. A configuration dialog box appears.

2. On the Configuration page of the configuration dialog box, set 
Pulse/Revolution to 2. Recall that you acquire the pulse per revolution 
information in the Tacho info indicator when you run the Getting 
Started Exercise VI for the first time.

3. Click the OK button to save the current configuration and close the 
configuration dialog box.

4. Wire the analog tacho signal output of the oax_Load Data (Analog 
Tacho, single channel) VI to the analog tacho signal input of the 
Analog Tacho Processing Express VI.

5. Wire the speed profile output of the Analog Tacho Processing Express 
VI to the Speed profile indicator. 

The block diagram should appear similar to Figure 2.

Figure 2.  Creating the Speed Profile

6. Run the Getting Started Exercise VI to calculate the rotational speed of 
the computer fan and to display the information in the Speed profile 
plot.

7. Save this VI.

On the front panel, the Waveform and Speed tab displays vibration signal 
and speed profile plots of the example data. From the Input signal plot, you 
can see that the vibration amplitude of the computer fan generally increases 
over 15 seconds. The Speed profile plot shows that the rotational speed of 
the computer fan increases steadily from approximately 1,400 RPM to 
3,700 RPM over 15 seconds. The Input signal and Speed profile plots 
therefore illustrate that the vibration amplitude is approximately linearly 
related to the rotational speed of the computer fan.
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Analyzing the Colormap
A colormap is a three-dimensional display of a sound or vibration spectrum 
as a function of time or speed. The spectrum can be a frequency or order 
spectrum.

Use the Spectral Map Express VI to compute the spectral map of a sound 
or vibration signal. This Express VI can return the spectral map in a 
colormap or a waterfall graph. You can use this Express VI to create a 
colormap of the computer fan run-up data.

Complete the following steps to compute and display the colormap of the 
computer fan run-up data.

1. Press the <Ctrl-E> keys to switch to the block diagram of the Getting 
Started Exercise VI.

2. On the Order Analysis Express Measurements palette, select
the Spectral Map Express VI and place it on the block diagram.
A configuration dialog box appears.

3. Click the OK button to save the current configuration and close the 
configuration dialog box. In this application, you can use the default 
configuration settings when you run the Spectral Map Express VI for 
the first time.

4. Wire the waveform signal output of the oax_Load Data (Analog 
Tacho, single channel) VI to the input signal input of the Spectral Map 
Express VI. 

5. Wire the speed profile output of the Analog Tacho Processing Express 
VI to the speed profile input of the Spectral Map Express VI. 

6. Wire the colormap output of the Spectral Map Express VI to the 
Colormap indicator.

The block diagram should appear similar to Figure 3.

Figure 3.  Creating the Colormap

7. Run the Getting Started Exercise VI to compute and display the 
colormap of the computer fan run-up data.

8. Save this VI.
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On the front panel, click the Colormap tab to view a colormap of the 
computer fan run-up data, as shown in Figure 4.

Figure 4.  Frequency-Time Plot

By default, this plot displays frequency against time. Red portions of the 
colormap indicate areas of strong amplitudes. Notice that several red lines 
appear on this colormap. These red lines correspond to strong vibrations at 
different frequencies in the data. Notice that the strongest vibrations occur 
at frequencies between 150 Hz and 400 Hz. This range most likely includes 
several resonant frequencies from the DUT.

You also can customize a colormap to display RPM against order. 
Complete the following steps to compute a colormap for the example
data that displays RPM against order. 

1. On the block diagram, double-click the Spectral Map Express VI to 
display the configuration dialog box.

2. On the Configuration page of the configuration dialog box, change 
the Plot type to RPM-Order. An RPM-Order plot displays how the 
vibration amplitude at different orders changes with the rotational 
speed. From the Colormap plot in Figure 5, you can see that the 
amplitude of the seventh order is the strongest around 2,600 RPM.
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Figure 5.  RPM-Order Plot

With this Colormap plot, you also can identify orders that correspond 
to loud noises or strong vibrations that you observe. For example, 
suppose the computer fan generates loud noises between 2,800 RPM 
and 3,000 RPM. From the RPM-Order plot, you can see that the fourth 
and the eighth order contribute the most to the loud noises in this speed 
range.

3. Click the OK button to save the current configuration and close the 
configuration dialog box.

A colormap plot therefore provides an overview of how the intensity of a 
signal relates to time, speed, frequency, and order. 

Analyzing the Order Power Spectrum
An order power spectrum provides a quantitative description of the 
rotation-related components of a signal. You can use an order power 
spectrum to find and compare significant orders. 

You can use the Order Spectrum Express VI to compute the order power 
spectrum of a sound or vibration signal. As you observed with the 
Colormap plot, the vibration amplitude of the seventh order is the strongest 
around 2,600 RPM. You can use the Order Spectrum Express VI to 
compute the order power spectrum of the example data at 2,600 RPM and 
to find the significant orders.
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Complete the following steps to compute and display the order power 
spectrum of the computer fan run-up data at 2,600 RPM.

1. On the Order Analysis Express Measurements palette, select
the Order Spectrum Express VI and place it on the block diagram.
A configuration dialog box appears.

2. On the Processing Settings page, set the Processing mode to Delta 
Speed.

3. In the Limit range options, set the Start speed (RPM) to 2600 and 
set the End speed (RPM) to 2600.

4. On the Spectrum Settings page, set Linear/dB to Linear.

5. Click the OK button to save the current configuration and close the 
configuration dialog box.

6. Wire the waveform signal output of the oax_Load Data (Analog 
Tacho, single channel) VI to the input signal input of the Order 
Spectrum Express VI.

7. Wire the speed profile output of the Analog Tacho Processing Express 
VI to the speed profile input of the Order Spectrum Express VI.

8. Wire the spectrum output of the Order Spectrum Express VI to the 
Order power spectrum indicator.

The block diagram should appear similar to Figure 6.

Figure 6.  Creating the Order Power Spectrum

9. Run the Getting Started Exercise VI to compute and display the order 
power spectrum of the computer fan run-up data.

10. Save this VI.
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On the front panel, click the Order Power Spectrum tab to display the 
Order power spectrum plot for the computer fan run-up data, as shown in 
Figure 7.

Figure 7.  Order Power Spectrum at 2,600 RPM

The Order power spectrum plot displays the order amplitudes at 
2,600 RPM. Notice that the seventh order has the strongest amplitude on 
the plot. The fourth order also is strong at 2,600 RPM. The seventh and 
fourth orders correspond to the seven blades of the fan and four coils of the 
electric motor, respectively.

Similarly, as you observed with the RPM-Order plot in the Spectral Map 
Express VI, the seventh order loses amplitude at around 2,900 RPM, and 
the eighth order gains amplitude around this rotational speed. 

Complete the following steps to compute and display the order power 
spectrum of the computer fan run-up data around 2,900 RPM. 

1. On the block diagram, double-click the Order Spectrum Express VI to 
display the configuration dialog box.

2. On the Processing Settings page of the configuration dialog box,
set the Start speed (RPM) to 2900, and set the End speed (RPM)
to 2900.

3. Click the OK button to save the current configuration and close the 
configuration dialog box.

4. Run the Getting Started Exercise VI.
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On the front panel, you can see that the eighth order now has a much greater 
amplitude than the seventh order does, as shown in Figure 8.

Figure 8.  Order Power Spectrum at 2,900 RPM

Again, the fourth order also is significantly strong at around 2,900 RPM. 
The eighth order and other order multiples of four correspond to the four 
coils of the electric motor of the computer fan.

An order power spectrum plot therefore provides detailed information 
about the strength of each order at a specific speed. You also can use the 
Order Spectrum Express VI to compute the strength of each order at a 
specific time and to perform spectrum averaging.

Analyzing the Magnitude Plot
A magnitude plot can help you analyze a sound or vibration signal by 
focusing on particular orders. 

Use the Order Tracking Express VI to compute the magnitude of 
designated orders. Recall that the Colormap plot showed the seventh order 
of the computer fan run-up data has a strong amplitude at 2,600 RPM. You 
can use a magnitude plot to observe this order in more detail.

Complete the following steps to compute and display the magnitude of the 
seventh order of the computer fan run-up data.

1. Press the <Ctrl-E> keys to switch to the block diagram of the Getting 
Started Exercise VI.

2. On the Order Analysis Express Measurements palette, select
the Order Tracking Express VI and place it on the block diagram.
A configuration dialog box appears.

3. On the Configuration page, set the Orders to track to 7. 
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4. Click the OK button to save the current configuration and close the 
configuration dialog box.

5. Wire the waveform signal output of the oax_Load Data (Analog 
Tacho, single channel) VI to the input signal input of the Order 
Tracking Express VI. 

6. Wire the speed profile output of the Analog Tacho Processing Express 
VI to the speed profile input of the Order Tracking Express VI.

7. Wire the magnitudes output of the Order Tracking Express VI to the 
Magnitude indicator.

The block diagram should appear similar to Figure 9.

Figure 9.  Creating the Magnitude Plot

8. Run the Getting Started Exercise VI to compute and display the 
magnitude of the seventh order of the computer fan run-up data.

9. Save this VI.

On the front panel, click the Order Tracking tab to display the Magnitude 
plot for the seventh order of the computer fan run-up data. You can see that 
this order has greater amplitude around 2,600 RPM, with a dip between 
2,450 RPM and 2,650 RPM, as shown in Figure 10. This dip is difficult to 
observe with the colormap alone.
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Figure 10.  Magnitude Plot of the Seventh Order

You also can use the Order Tracking Express VI to compare the magnitudes 
of different orders. For example, if you add a second element to the Orders 
to track input and set the element to 8, the Magnitude plot displays the 
seventh and eighth orders together, as shown in Figure 11.

Figure 11.  Magnitude Plot of the Seventh and Eighth Orders

As you observed with both the Colormap plot and the Order power 
spectrum plot, the amplitude of the eighth order increases as the amplitude 
of the seventh order decreases between 2,800 RPM and 3,000 RPM. The 
Magnitude plot provides a detailed view of exactly how the two orders 
change in magnitude with changing speed.

In the configuration dialog box of the Order Tracking Express VI, you can 
set the X-axis selection of the Magnitude plot to display the order 
magnitude against time, speed, or number of revolutions. You also can use 
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the Magnitude View options to specify the type of quantitative 
measurement you want to use to calculate and display the magnitude.

Whereas an order power spectrum shows the magnitude or power values of 
all orders at a specific period in time or at a specific speed, the Magnitude 
plot provides detailed information about particular orders that you specify.

Extracting Order Waveforms
You can extract order waveforms to isolate specific orders from a sound or 
vibration signal. The order waveform provides detailed information about 
the specific order you extracted from the input signal. You then can 
perform further analysis, such as sound playback and sound synthesis, on 
these significant orders. 

Use the Order Waveform Express VI to extract order waveforms. As you 
observed with the Colormap, Order power spectrum, and Magnitude 
plots, the seventh order is one of the orders that has strong amplitude in the 
computer fan run-up data. You can use the Order Waveform Express VI to 
extract and display the order waveform of the seventh order of the computer 
fan run-up data.

Complete the following steps to extract and display the order waveform of 
the seventh order from the computer fan run-up data.

1. On the Order Analysis Express Measurements palette, select the 
Order Waveform Express VI and place it on the block diagram of the 
Getting Started Exercise VI. A configuration dialog box appears.

2. Click the OK button to save the current configuration and close the 
configuration dialog box. In this application, you can use the default 
configuration settings when you run the Order Waveform Express VI 
for the first time.

3. Wire the waveform signal output of the oax_Load Data (Analog 
Tacho, single channel) VI to the input signal input of the Order 
Waveform Express VI. 

4. Wire the speed profile output of the Analog Tacho Processing Express 
VI to the speed profile input of the Order Waveform Express VI.

5. Wire the order list output of the Order Waveform Express VI to the 
Order list indicator.
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6. Wire the order waveform output of the Order Waveform Express VI 
to the Order waveform indicator.

The block diagram should appear similar to Figure 12.

Figure 12.  Extracting Order Waveforms

7. Run the Getting Started Exercise VI. 

8. Double-click the Order Waveform Express VI to display the 
configuration dialog box. You can see the colormap of the computer 
fan run-up data in the Colormap plot.

9. On the Order Selection page, set Order to preview to 7.

10. Click the Extract button to extract the order waveform of the seventh 
order.

11. Select the seventh order in the Extracted orders list.

12. Click the Export button to export the order waveform of the seventh 
order to the block diagram. Clicking the Export button also adds the 
seventh order to the Output list.

13. Click the OK button to save the current configuration and close the 
configuration dialog box.

14. Run the Getting Started Exercise VI again to extract and display the 
waveform of the seventh order of the computer fan run-up data.

15. Save this VI.
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On the front panel, click the Order Waveform tab to display the Order 
waveform plot of the seventh order, as shown in Figure 13.

Figure 13.  Waveform of the Seventh Order

You also can use the Order Waveform Express VI to extract multiple orders 
of a signal that generate the greatest amplitude, or produce the strongest 
noise. As you observed with the Colormap, Order power spectrum, and 
Magnitude plots, the fourth, seventh, and eighth orders have relatively 
strong amplitudes in the computer fan run-up data.

Complete the following steps to extract and display the waveforms of the 
combination of the fourth, seventh, and eighth orders.

1. Press the <Ctrl-E> keys to switch to the block diagram of the Getting 
Started Exercise VI.

2. Double-click the Order Waveform Express VI to display the 
configuration dialog box.

3. On the Order Selection page, set Order to preview to 4.

4. Click the Extract button to extract the order waveform of the
fourth order.

5. Set Order to preview to 8.

6. Click the Extract button to extract the order waveform of the
eighth order.

7. In the Extracted orders list, press the <Ctrl> or <Shift> key to select 
the fourth, seventh, and eighth orders simultaneously.

8. Click the Export button to export the combined order waveform of the 
fourth, seventh, and eighth orders to the block diagram. Clicking the 
Export button also adds the combination of the fourth, seventh, and 
eighth orders to the Output list.

9. Click the OK button to save the current configuration and close the 
dialog box.
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10. Run the Getting Started Exercise VI. 

11. Save this VI.

On the front panel, the Order waveform plot now displays both the 
waveform of the seventh order and the waveform of the combination of the 
fourth, seventh, and eighth orders, as shown in Figure 14.

Figure 14.  Comparing Order Waveforms

You can add different order waveforms together in different combinations. 
You then can play back the resulting waveforms as sounds and determine 
which combination is the most pleasing to the ear. This way, you can 
determine how to reduce the harshness of the signal and how to remove 
undesirable sounds and vibrations.

Summary
You can use the Order Analysis Express Measurements VIs to perform 
most common types of order analysis. You can use these VIs and the 
following plots to display data from different perspectives:

• Vibration signal plot

• Speed profile plot

• Colormap

• Order power spectrum

• Magnitude plot

• Order waveform
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